
Index
Numerics
24bit 17-4
3D surface 16-1
8bit RLE 15-4

A
Active Image 5-9–5-10
Actual Image Resolution(1-1) Tool

5-35
Actualize an Image 5-35
Affinity 5-29
Affinity Handles 5-23
Anchor Point 7-4, 7-7, 7-11, 7-12,

7-14
Arc Recognition 13-31, 13-32

Auto Convert Arcs 13-31
Associating a MicroStation 

Descartes Images to a 3D 
Surface 16-2

Auto Convert 13-45
Auto Place Nodes 13-45
Automatic Line Conversion 13-1,

13-4
Automatic Line Conversion Settings

13-33

B
Background Color 5-18, 7-16, 7-24,

7-27
Balance Tone tool 9-1

Balance Tool Options - 
Average Mode 9-2

Balance Tool Options - 
From Reference Mode 9-3

Balance Tool Options - 
Source Area 9-3

To Tone Balance with 
Average Mode 9-4

To Tone Balance with From
Reference Mode 9-5
Base Document 8-1
Basic Macros 18-13, 18-15
Batch Conversion Dialog Box 1

5-1–15-4
Color Compression 15-3, 15-4
Data Compression 15-3
image formats 15-2
Image Preview 15-2
image types 15-2

Break Points 13-3
Bring Images to Front 5-11
Bring Images to Front Tool 5-33
Bring Individual Images to 

Front 5-11
Brushing an Image 11-1
Building a Model 8-3

base geometry 8-3
dynamic warping 8-4
exact control point 8-4
fuzzy control points 8-3
geometric correction 8-3
target geometry 8-3
what you see is what you 

get 8-3

C
CAD Overlay Image Menu 

18-3–18-13
CAD Overlay Workspace 

18-3–18-13
CALS 1 File Support 15-4
Cell 12-3
Center on Cursor 13-44
Center on Last Point 13-44
Center Views 13-32
Change Mode 13-43
Circle Recognition 13-32
Clean Up Tool Box 11-20–11-22

Mesure Speckle 11-22
Remove Holes 11-21
Remove Speckle 11-20

C
C
C
C
C
C
C

C
C

C
C

C
C

C

C
C
C
C
C
C

C
C
C
C
C
C

MicroStation D
lip 7-26
lose Element 13-44
losing Images 5-16
olor Composite 6-14
olor Composite Image 6-14
olor Compression 6-14–6-17
olor Compression Encoding Key

6-15, 6-16
olor Compression Polygons 6-15
olor Compression Setup 

6-16–6-17
olor Compression Weights 6-15
olor Distribution 3-22

Exact Design Colors 3-22
Exact Image Colors 3-22
Exact MicroStation Colors 3-22

olor Filter Dialog Box 10-5–10-7
olor Filter File Tool Box 

10-4–10-5
Color Filter Dialog 10-5
New Color Filter File 10-4
Open Color Filter File 10-4
Save Color Filter File 10-5

olor Filter Tool Box 10-2–10-4
Add to Filter 10-2

color indices 10-2
Color Filter Dialog 10-4
Highlight Filter 10-3
Substract from Filter 10-2

olor Filters 10-1–10-7
olor Index 6-6, 6-16
olor Min/Max 7-27
olor Palette 6-19, 6-21, 10-1
olor Sampling Tool 6-19, 6-22
olor Table Concepts 3-19

color palette 3-19
olor Table Editing 6-5–6-6
olor Table Editor 5-13
olor Table File 6-4, 6-6, 6-10
olor/Gray Scale 6-4
ompression Options 6-15
oncepts 13-3
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Configuration Plot Files 17-17, 
17-18, 17-19
Inverting two-color images 

17-17
modify the PLT file for Plot On

The Fly 17-18
Plotting Design 87 and 88 

Elements 17-17
RTL Plotting - Exceeding 

Installed Memory on 
Plotter 17-17

send the plot file to the plotter
17-18

Configuring Cache Memory 20-6,
20-7, 20-8
Cache Directory 20-7
Clear Cache button 20-7
Disk Cache Maximum Size

(MB) 20-8
File Caching Threshold (KB)

20-8
Memory Cache Maximum Size

(MB) 20-8
Select button 20-7
To access the Cache Options

20-7
Configuring MicroStation Descartes

to Access a MSI Server 20-2
Continue Element 13-12, 13-28
Contrast Stretch 6-7–6-9, 6-14
Convert All Connected Lines 13-18,

13-19, 13-28
Convert Circle 13-21, 13-22, 13-28

raster circle 13-21
Convert Contour Lines 13-19, 

13-21, 13-28
Active Z 13-19
Auto Continue 13-19
convert a series of raster 

contour lines 13-20
convert one raster contour line

13-20
Convert Lines 13-15–13-18, 13-28

Auto Continue 13-16
Line entity 13-16
Outline entity 13-17
raster branches 13-17

Converting a Remote Image - Batch
Conversion and/or Save As...
20-10

Converting Cells 14-1–14-8
Converting Image Formats 

15-1–15-11
Converting Text 14-1–14-8
Coordinate System 8-1
Copy Design Elements 7-25
Copy Project 3-9–3-13, 17-4
Copy Project Dialog 3-10

Archive File goup > Select 
button 3-12

Copy To group > Select button
3-12

Method 3-11
Overwrite Existing Files 3-11
Save Directories 3-11
To create a backup or a copy

of a project 3-12
To create a self-extracting 

archive of a project 3-13
Copy/Paste Tool Box 11-23–11-24

Copy Image Area 11-23
Copy Image Settings dialog

box 11-24
Copy Image Settings tool 

11-24
Paste Image Area 11-23
Paste Image Area as Design 

Element 11-23
Corridor 7-23
Creating Mosaics 6-1
Custom Compression 6-17
Customizing Descartes 18-1–18-17

key-ins 18-1
MDL programming language

18-1
UCM 18-1

D
Data Compression 6-15
Data Conversion 13-1
Define Seam tool 9-5

Seam Tool Options > Seam
Type  9-6

To Mosaic Two Images Using
Quick Mode 9-9

Tool Options > Feathering 9-8
Tool Options > Width 9-8

Degree of Translucency 6-21
Delete Nodes 13-25, 13-26
Density Slicing 6-10–6-13
Descartes Plotting Dialogs 

17-11–17-15
Gray Scale 17-12
Plot Raster Images 17-12

Destination Polygon 7-9, 7-23
Displaying Images 5-1–5-36
Draping and Rendering? 16-1
Drawing in Raster 11-1
Dynamic Binariser 10-1

E
Edit Menu 4-13–4-14

Copy 4-14
Redo 4-14
Set Active Image 4-13
Undo 4-13

Editing Images 11-1–11-25
Enhance 24bit Color Compression

and Dithering 17-4
Enhancing Images 6-1–6-22
Erase Raster Behavior 13-27
Erase Raster Option Button 13-27
Erase Tool Box 11-4–11-6

Erase Area 11-5
Erase with Circular Brush 11-5
Erase with Oblique Brush 11-5
Erase with Rectangular Brush

11-4
Erasing Raster while Vectorizing

13-27, 13-28
Exponential Curve 6-7

F
File Menu 4-7–4-11

Batch Conversion 4-10
Close All Images 4-8
Close Images 4-8
Fourth last image name 4-11
Image Project sub menu 4-10
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Image Properties sub menu 
4-9

Last image name 4-10
New Images 4-7
Open Images 4-8
Print/Plot 4-10
Save Image 4-8
Second last image name 4-10
Third last image name 4-10

File Type 7-26
Fit All Images to View 5-34
Fit All Images to View Tool 5-34
Fit Images to View Tool 5-34
Fitting Images to a View 5-14
Foreground Color 7-2
Full Resolution 5-15

Actual Resolution (1-1) 5-15
Function Keys 13-34, 13-35, 

13-43–13-45
Fundamentals 3-1–3-24

G
General Image Properties Dialog

Box 5-13
Generalization 13-4, 13-36

Stream Parameters 13-36
Georeferencing and Geocoding

Support 15-5
GeoTIFF Conversion Options 

Dialog 15-6
Coordinate System 15-6
Location Format 15-6
Projection 15-6

GEoTIFF Image Location Dialog
15-7

GeoTIFF Related Keyins 15-7, 15-8
GeoTIFF Support 15-4–15-10
GPS System 8-1

H
Hatch 12-3
Hatch Editing Dialog Box 

12-16–12-17
Heads-Up Digitizing 13-1
Help Menu 4-30

About Descartes 4-31

Contents 4-31
Histogram Display 5-13, 6-2–6-3
Histogram Exploration 6-2
HMR Images 3-19
Horizontal Mirror Image Area 7-8
How to Start MicroStation 

Descartes 3-1
Hybrid 17-1

I
Image Border 5-30

visibility of images 5-31
Image Channels 6-3–6-5
Image Control Tool Box 5-33–5-34
Image Dimension 5-27
Image Draping 16-1–16-3
Image Enhancement 6-1
Image File Formats 15-10, 15-11
Image File Header 7-10
Image File Tool Box 5-35–5-36
Image File Types 3-16

image file formats 3-16
image file types 3-16

Image Lists 5-4–5-16
active image 5-8

active image 5-9
Applying a list of images to

other views 5-5
Assigning one view to the list

box 5-4
Creating new images 5-6
Opening images 5-5, 5-6
Selecting images 5-6

Selected images 5-6
Image Location 5-13
Image Location Dialog Box 

5-27–5-29
Image Manager 5-1–5-36
Image Manager Dialog Box 5-3

color encoded images 5-3
grayscale images 5-3
Image list box 5-3
monochrome images 5-3

Image Manager Dialog Tool 5-36
Image Manager Display menu 

4-15, 4-16, 4-17

Actual Resolution 
(1:1) 4-16

Apply to 4-17
Apply to All 4-17
Bring to Front 4-15
Contrast/Brightness 4-17
Fit All Images to View 4-16
Fit Images to View 4-16
Images On 4-15
Send to Back 4-15

Image Manager Environment 
Variable 3-23
create the environment 

variable 3-23
set the environment variable

3-23
Image Origin 5-27
Image Preview 5-21
Image Properties 5-12–5-14
Image Resampling 8-5

Bilinear Interpolation 8-5
Cubic Convolution 8-5
Nearest Neighbor 8-5

Image Transform 7-1, 7-10–7-28
Insert Element 13-13, 13-14, 13-15,

13-28
Inside 7-26
Install 1-2
Installing MicroStation Descartes

on a Network Client 19-2
Installing MicroStation Descartes

on a Network Server 19-1
Installing MicroStation Descartes

To Run from a Network Server
19-1–19-4

Installing the MSI Client for MicroS-
tation Descartes 20-2

Integration with rendered objects
16-2

K
key-ins 18-1

L
Line Conversion 13-1
Line Editiing 13-1
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Line Quality 13-33
Linear Curve 6-7
Local Transform 7-1, 7-2–7-10

M
Main Menu 3-2

workspaces 3-3
Managing Files 3-14, 3-15

file types 3-14
Managing groups of images with

projects 3-9
Maximum Line Width 13-33
Memory Allocation 3-20–3-21

Image File Buffers 3-21
Screen Tile Buffers 3-21

Menu Structure 4-3–4-7
Display Menu 4-5
Edit Menu 4-5
File Menu 4-4
Help Menu 4-7
Preferences 4-6
Settings Menu 4-5
Tools Menu 4-6
Utilities Menu 4-7

Merge Images 7-21–7-22
MicroStation J

Color Distribution 3-23
MicroStation J Support 3-1
Mirror Image tool 7-16

transformation matrix 7-17
using the transformation 

matrix 7-16
Mirroring Direction 7-17
Modify Image Tool 7-10
Mosaic 7-21
mosaic 3-9
Mosaic Toolbox 9-1–9-9

Balance Tone tool 9-1
Mosaicing Tools 9-1–9-9
Move Image 7-11
Move Image Area 7-3
Moving Images Backward 

5-10–5-12
Moving Images Forward 5-10–5-12
Moving the Image 5-23
MS Descartes as a MSI Client 

20-1–20-13

MSI Server Failures 20-11, 20-12,
20-13
Setting the Number of connec-

tion retries 20-12
To change the number of 

retries 20-12

N
Naming Convention 3-17

extension TWF 3-17
Navigating 4-1–4-31
New Image Dialog Box 5-17–5-19
New Image Tool 5-35
New Node File 13-29
Nodes 13-3, 13-37–13-40

Auto Place Nodes 13-38
firewalls 13-40
structured vector data 13-40
topologically ready 13-40

O
Open and display a GeoTIFF image

 15-8
Open Image Dialog Box 5-19–5-21
Open Images Tool 5-36
Open Node File 13-29
Opening Images on Remote MSI

Server(s) 20-9
Output Color Table 7-27
Output Image Creation 7-24–7-26
Output Settings dialog box 7-26
Overlap 7-26
Overview 2-1–2-5
Overview of a Draping Process 

16-3

P
Paint Tool Box 11-2–11-4

Paint Area 11-3
Paint with Circular Brush 11-3
Paint with Oblique Brush 11-3
Paint with Rectangular Brush

11-2
Pair of Points 7-10
Pairs of Points 7-20

Pattern 12-3
Pattern Editing Dialog Box 

12-18–12-19
Cell 12-18

Percentage of Translucency 6-21
Pixel Size 5-28, 7-28
Place Element 13-8–13-12, 13-28

Arc mode 13-9
Point mode 13-9
Steam mode 13-9
To bridge gaps 13-12

Place Image Area 7-9–7-10
Place Interactively 5-21
Place Mode 5-18–5-19
Place Nodes 13-22–13-25
Plotting Images 17-1–17-20
Plotting under MicroStation 5.5.xx

for DOS 17-16
Positive/Negative 6-4
PostScript 17-1
Print Images Tool 5-36
Printing Images 17-1–17-20
Programming with MDL 18-15, 

18-16, 18-17
Project Sub Menu 4-11–4-13

Attach Project 4-12
Detach Project 4-12
Export Raster Reference 4-13
Import Raster Reference 4-12
New Project 4-11
Open Project 4-11
Save Project 4-11
Save Project As... 4-12

Projects 3-4–3-9
Attaching a project 3-7, 3-8

Full Path 3-7
Project Settings 3-7

Project files 3-5, 3-6
Publish To Viewer

Publish (Using) 17-9
Publish to Viewer 17-4–17-11

Publication File 17-4
Publishing Images 17-1–17-20

R
Raster End Points 13-4
Raster Intersection Points 13-4
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Raster Lines 13-4–13-7
Raster Objects 7-2, 13-5
Raster Outlines 13-4–13-7
Raster Plotfile 17-2
Raster Reference Files 3-13
Raster Snap 13-45
Raster to Vector Line 

Conversion 13-1
Red,Green, Blue 6-4
Redo Vertex 13-44
Register Concepts 8-2

base 8-2
uncorrected data 8-2

Register Dialog Box 8-6–8-20
Actual Model 8-10
Add Control Points 8-12
Affine-1 model 8-8
Apply menu 8-20
Auto Locate 8-16
Base System X, Y 8-10
Control Point # 8-10
control points mark 8-18
Coordinate System 8-13
Delete Control Points 8-13
detailed view 8-16
Dynamic Warping 8-14
Edit menu 8-12
File menu 8-12
Helmert model 8-7
Highlight Control Points 8-13
Image Resampling dialog box

8-20
Locate Control Points 8-13
Model Selected 8-7

Actual Model 8-7
base system 8-7
control points 8-7
residuals 8-7
uncorrected system 8-7

Modify Control Points 8-13
On 8-10
On/Total 8-12
Pinning control points 8-16
Polynomial-2 and 3 models

 8-9
Projective model 8-9
Residuals 8-11
Settings menu 8-18

Colors for Control Points
8-18

Elements Transformation
8-19

Warning when Renum-
bering 8-19

Similitude model 8-8
Standard Deviation 8-12
synoptic view 8-16
Thin Plate Spline model 8-9
Tools menu 8-18
Uncorrected System X, Y 8-11
View > Show Control Points 

8-18
View menu 8-14–8-18
Views Displaying Uncorrected

Data 8-15
Warping Window 8-17

Register File Tool Box 8-25–8-26
New Register File 8-25
Open Register File 8-26
Register Dialog 8-26
Save Register File 8-26

Register Tool Box 8-20–8-25
Copy Vector 8-22
Delete Control Points 8-22
Move Control Point 8-21
Move Vector 8-23
Place Control Points tool 8-20
Register Dialog 8-25
Resample Image 8-25

Registering Images 8-1–8-34
Registering Vector Data 8-1–8-34
Resampling Dialog Box 8-28–8-34

All Input Image 8-30
All Input Image/Output 8-30
Bilinear Interpolation 8-31
Create a new image 8-28
Cubic Convolution 8-31
File menu 8-34
Input Image field 8-29
Job Manager 8-33
Model field 8-29
Nearest Neighbor 8-31
Output Image field 8-29
Tools menu 8-34
Warping Window 8-31

Resampling File Tool Box 
8-27–8-28
Image Resampling 8-28
New Resampling File 8-27
Open Resampling File 8-27
Save Resampling File 8-27

Resampling Parameters 7-17, 7-21
Resampling the Image 7-10
Resolution 13-34
RGB Channels 6-3
RGB Color Cube 6-16
RGB Combination 6-14
rotate an image interactively to 

create a new image 7-14
rotate an image to a specified angle

creating a new image 7-15
rotate an image using the 

transformation matrix 7-13
Rotate Image 7-13–7-16
Rotate Image Area 7-6–7-7
Rotation 5-29, 5-31, 7-6, 7-14

image rotation 5-31
Rotation Angle 7-6
Rotation Handles 5-23
Rotation Origin 7-14
Rubber Band 7-22
Running MicroStation Descartes

from a Network Server and/or
Client 19-3

S
save an image AS a GeoTIFF

 15-9
Save As Dialog Box 5-25–5-26
Save Image Tool 5-36
Save Node File 13-29
Save Node File As 13-30
Saving Images 5-15
Scale Factor 5-28
Scale Image 7-12
Scale Image Area 7-4–7-6
Scaling Handles 5-22
Select Images/Active Image 

Tool 5-33
Send Images to Back 5-11

Send to Back 5-11
Send Images to Back Tool 5-33
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Send Individual Images to 
Back 5-11

Set the New View Center 5-35
Setting up the network client 19-3
Setting up the servers 20-3
Settings Menu 4-17–4-20

Lock 4-19

Image Lock 4-19
Preferences > Color 

Distribution 4-18
Preferences > Memory 4-18
Project 4-19
Raster Snap on Tentative 4-18
Stamp Vector 4-19
Undo 4-19
Vectorize 4-19
View Image Attributes 4-20

Slice Coloring 6-12
gradation of colors 6-12

Snap/Break Vector 13-45
Snap/Insert Vector 13-44
Source Polygon 7-9, 7-23
Spy Window 13-40, 13-41, 13-43
Spy Windows 13-45
square an image by resampling 

7-18
Square Image 7-17
Square Image tool

To square an image 7-18
Stamp In A New File 11-15
Stamp in a New File Dialog 

11-11–??
Stamp Settings 11-17
Stamp Vector Tool Box 11-6–11-20

Automated Vector Stamping
Settings 11-7

Automatic Vector Stamping
11-19

Match Stamp Vector Settings
Tool. 11-16

Solving color conflicts 11-7
Stamp in a New File Dialog 

11-11–11-15
Stamp In A New File tool 

11-10
Stamp Vector 11-9
Stamp Vector Settings 11-17

Stamp Vector Settings dialog
box 11-18

Stamp Vector tool box
Stamping into two-color

 images 11-6
Standard Compression 6-17
Standard Transformation 8-4
Starting MicroStation Descartes 

4-1–4-2
“dcartes” workspace 4-2
full integration 4-2
minimal integration 4-1

Statistics 6-3, 6-9
Step Angle 7-22
Symbology 12-3
Symbols 14-1

T
Text/Cells Tool Box 14-1–14-8

Convert Cells 14-6
Convert Horizontal Cell 14-6
Convert Oriented Cell 14-7,

14-8

Erase Raster 14-8
Convert Text 14-3, 14-4, 14-5,

14-6

Erase Raster 14-4
Text Editor 14-5

Select Horizontal Text 14-2
Select Oriented Text 14-3

The Node File Tool Box 13-29, 
13-30

Theme 12-3
Theme File Tool Box 12-5–12-6

New Theme File 12-5
Open Theme File 12-5
Save Theme File 12-6
Theme Styler Dialog 12-6

Theme Styler Dialog Box 
12-6–12-16
Cell Attributes 12-11

Display Theme 12-14
Update Design File 12-15

Contour Color 12-9
Filling closed elements 12-9
Line Style 12-9
Line Weight 12-9

Text Attributes 12-10

Color 12-10
Font 12-10
Height 12-11
Interchar Spacing 12-11
Justification 12-11
Line Spacing 12-11
Slant 12-11
Underline 12-11
Vertical Text 12-11
Width 12-11

theme used 12-8
To add a theme 12-7
To delete a theme 12-7
To modify a theme 12-7
Visible 12-8

Theme Symbology 12-1–12-21
Theme Tool Box 12-4–12-5

Change Theme 12-4
Query Theme 12-4
Select by Theme 12-5
Theme Styler Dialog 12-5

Themes 12-1
to Mirror an Image Area 7-8
to Modify the Geometry of an 

Image 7-19
to Reverse an Image 7-17
To setup MicroStation Descartes on

the server 19-1
Tool Boxes 3-3
Tool Frames 3-3
Tools Menu 4-20–4-28

Clean Up tool box 4-21
Color Filter File tool box 4-22
Color Filter tool box 4-22
Convert To Vector 4-21
Copy/Paste tool box 4-22
Erase tool box 4-23
Image Control tool box 4-23
Image File tool box 4-23
Image Transform tool box 

4-24
Local Transform tool box 4-24
Node File tool box 4-25
Paint tool box 4-25
Register File tool box 4-26
Register tool box 4-25
Resampling File tool box 4-26
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Stamp Vecto tool box 4-26
Text/Cells tool box 4-27
Theme File tool box 4-27
Theme tool box 4-27
Tool boxes 4-20
Tool Frames 4-20
Undo/Redo tool box 4-28
Vectorize tool box 4-28

Tools Settings Fields 5-23
Tools Settings>Scale Factor 5-24
Transform Operations 7-2
transformation matrix 7-17
Transformation Model 7-10, 7-21
Transformation Models 8-2

Affine 8-2
bilinear interpolation 8-2
cubic convolution 8-2
Helmert 8-2
nearest neighbor 8-2
Polynomial 8-2
Projective 8-2
Similitude 8-2
Thin Plate Spline - No 

Residuals 8-2
warping process 8-2

Transforming Images 7-1–7-28
Translation 7-4
Translucency 5-32, 6-20
Translucency Mechanism 6-20
Translucent Colors 6-20–6-22
Transparency 5-31, 6-18
Transparency Mechanism 6-18
Transparent 7-2, 7-16, 7-27
Transparent Colors 6-18–6-20
Turning Images Off 5-12
Turning images off 5-12
Turning Images On 5-12
Turning images on 5-12

U
Undo Tool Box 11-24–11-25

Redo Image 11-25
Undo Image 11-24
Undo Image Settings dialog

box 11-25
Undo Image Settings tool 

11-25

Undo Vertex 13-43
Undo/Redo Behavior 13-28
Update Design File Dialog Box 

12-19–12-20
User Interface Conventions 3-1

project metaphor 3-2
Utilities Menu 4-28, 4-29, 4-30

Color Compression 4-29
Color Filter 4-29
Contrast Stretch 4-29
Density Slicing 4-29
Image Channels 4-29
Register 4-30
Theme Styler 4-30
Translucent Colors 4-30
Transparent Colors 4-30

V
Vector Plotfile 17-2
Vector Resampling 8-6
Vectorize Functions 13-43–13-45
Vectorize Settings 13-27
Vectorize Tool Box 13-7–13-29

complex chains 13-7
locate tolerance 13-8

line conversion tools 13-7
Vectorize Tools Supporting Raster

Erase 13-28
Vectorizing 13-1–13-45
Vectorizing Settings Dialog Box 

13-30–13-43
Vertical Mirror Image Area 7-8–7-9
View Image Attributes Dialog Box

5-30–5-33

W
warp an image by resampling 7-20
Warp Image 7-19–7-21
Warp Image tool

To warp an image 7-19
Warping Images Register 8-1

Batch resampling 8-1
Dynamic warping 8-1
Polynomials models 8-1
Transformation of vector data

8-1

Warping Images with Register
No-Residual Transformation

model 8-1
Workspace 18-3
World File Support 3-17, 3-18

raster format 3-17
Why Use WorldFiles 3-17
worldfiles 3-17
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